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Apple Push Notification Service
(APNS)

What Is APNs

Apple Push Natification service (APNSs) is a highly secure and efficient system for communicating with iOS
devices over-the-air (OTA). Each device establishes an accredited and encrypted IP connection with the
service. The provider, in this case your ZENworks Mobile Management server, connects with and sends its
notification to the APNs, which pushes the notification to the target device.

An APNSs certificate is required for Apple Push Notification service. The certificate must be renewed annually.
This guide explains the process of obtaining the APNs certificate from Apple and provides instructions on how
to upload the certificate to the ZENworks Mobile Management server via its dashboard.

There are various methods of generating the APNs certificate, any of which you may use. This document
guides you through generating the certificate by using Microsoft Windows Internet Information Services (11S)
Manager, version 6 or 7.

How APNs Works

Apple Push Notification service works in conjunction with the built-in MDM protocol of Apple iOS devices.
ZENworks Mobile Management uses the Apple Push Notification service to send notifications to the iOS
device requesting information. Only notifications, not data, are not sent through the APNs server. The device
responds directly to the ZENworks Mobile Management server.

The Apple MDM protocol provides the following functionality:
o Devices support Selective Wipe, Lock Device, and Clear Passcode
e Full Wipe and Lock Device commands are applied immediately
e You can record and access installed applications on devices
e You can record and access installed configuration profiles on devices
e You have access to additional device statistics
e Configuration profile updates require no user interaction
e Enterprise (in-house) apps
e Mobile App Management
¢ Manage VPP (Redemption) Codes
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Requirements

ZENworks Mobile Management version 2.5.2 or later

An Apple ID. We recommend that you do not use a personal Apple ID, but create a separate
corporate Apple ID for MDM. Associate the Apple ID with an email account that will remain with your
company — not an email account that belongs to an individual in the company. This facilitates a
smooth certificate renewal process each year.

Windows Server 2003 or 2008 (you need administrator permissions)

Firefox or Safari Web browser

An Overview of the Steps to Obtain the Apple Push Notification Service Certificate

Create a Certificate Signing Request (CSR). (This guide provides instructions for creating the
certificate from Microsoft Windows Internet Information Services (lIS) Manager, version 6 or 7.)

Upload the CSR to the ZENworks Mobile Management Certificate Portal. Novell, Inc. signs the CSR.
Upload the intermediate certificate (the CSR signed by Novell, Inc.) to the Apple Push Certificates

Download the signed certificate from the Apple Push Certificates Portal and complete the certificate

1.
2.
3.
Portal. Apple issues the certificate.
4.
request in IIS.
5. Export the certificate to a file.

Upload the certificate to the ZENworks Mobile Management server.

Generating an Apple Push Notification Service Certificate for use with ZENworks Mobile

Management for iOS

1.

Create a Certificate Signing
Request (CSR) in lIS.

The IS server and the
ZENworks server can be the
same server, but this is not

required.
Use lIS to complete the
certificate request
process by using the
certificate issued by
Apple.

Novell

5.

Export the certificate you just
created as a .pfx file.

(Create a password while
exporting.)

Use the ZENworks Mobile
Management dashboard to upload
the APNs certificate to the ZENworks
server.

Log in to the dashboard with the
external server address so that the
Use Default URLs option can be
utilized.

2.

Upload the CSR to the ZENworks Certificate
portal to get it signed by Novell. A .request
file is generated.
https://zmmupdate.novell.com/apn/

Upload the signed Intermediate Certificate to
the Apple Push Certificates portal. Apple
issues the certificate in a .pem file

format. Download this file.

https://identity. apple.com/pushcert/

ZENworks Mobile Management 2.5.x Generating an APNs Certificate

Apple Push Notification Service (APNs) o 5



Generating an APNs Certificate

Generating an APNs Certificate from Windows Server 2003

The following instructions are for generating an APNSs certificate from a Windows Server 2003 by using
Internet Information Services (1IS) Manager version 6. You can skip this section if you use Windows Server
2008. Instructions for 2008 are in another section of this document.

Creating the Certificate Signing Request (CSR) from IIS Manager 6

1. Select Start > Control Panel > Administrative Tools > Internet Information Services (1IS)
Manager.

2. Right-click any Web site in the left panel. Select Properties.

Select the Directory Security tab and then click the Server Certificates button in the Security
section of the menu. This starts the Web Server Certificate Wizard. Click Next to continue.

WebSte |  ISAPIFites |  HomeDiectory |  Documents
Diectory Securty | HTTP Headers | CustomEmors |  ASP.NET

r Anorymous access and authentication control
! ; Enable anonymous access and edit the

authentication methods for this resounce. Edit... |

- IF addiesz and domain name restrictions

@ [Frant on deny access b this resounce wsing

|F addreszes arnintermet domait names.
Edit... |
_ S »
Secure communications »
Require secure communications and -
enable client cerfficates when this Server Cetficate...
resource is accessed. : .
Wiew Certifizate,. |
Edit.. |

oK Cancel |t | Hep |
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115 Certificate Wizard

4. Select the Create a new certificate option and click Next.

5. Select Prepare the request now, but send it later option and click Next.

IS Certificate Wizard
Server Certificate
There are five methods for assigning a certificate to a Web ste

Select the method you want to use for this web site:
(¢ Create a new cerdificate.

(" Assign an existing certificate

" Import a certificate from a Key Manager backup file.

Delayed or Immediate Request

You can prepare a request to be sent later, or you can send one
immediately.

Do you want to prepare a certificate request to be sent later, or do yo
immediately to an online certification authority?

¥ Prepare the request now, but send it later
€ Send the request immediately to an

iy thifimabiny tHhamrit
online cerancauon autrorty

6. Enter a certificate name that is easily remembered. In the Bit length field, select 2048 for the
encryption level, then select Select cryptographic service provider (CSP) for this certificate. Click

Next.

7. From the Available Providers window, select Microsoft RSA SChannel Cryptographic Provider.

Click Next.

Mame and 5ecurity Settings
Your new certificate must have a name and a specific bit length.

Type a name for the new certificate. The name should be easy for you to refer to and
remember.

Mame:

The bit length of the encreption key determines the certificate’s encryption strength.
The greater the bit length, the stronger the security. However, a greater bit lehgth may
decreasze performance.

Bit length: I 2048 - l

[T Select cryptagraphic service provider [CSP) for this cerificate

< Back I Mext > I Cancel

IS Certificate Wizard
Available Providers

The cryptographic providers you can use for your certificate are listed
below

Select a provider

Microsoft DH SChannel Cryptographic Provider
Microsoft RSA SChannel

ptographic Provider
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8. Enter the legal name of your Organization and the Organization unit, which is the department

within your organization. Click Next.

9. Inthe Common name field, enter a valid Apple ID. This does not need to be an Apple Developer
account ID, but you should use an Apple ID that has been designated for managing the corporate
APNs certificate. The Apple ID might be in the form of an email address, or possibly a display name.

Click Next.

115 Certificate Wizard

Organization Information
‘r'our certificate must include information about your organization that
digtinguishes it from other organizations.

Select or type your organization's name and pour arganizational unit. This iz typically the
legal name of pour organization and the name of vour division or department.

Far further infarmation, consult certification authority's Web site.

Organization:

INoveII, Inc. j
Organizational unit:

fil =l

Caneel

< Back I MHest = I

1IS Certificate Wizard
Your Site's Common Name
Your Web site's common name is its fully qualified domain name.

~

Type the common name for your site. |f the server is on the Intemet, use a valid DNS
name. If the server is on the intranet, you may prefer to use the computer's NetBIOS
name.

If the common name changes, you will need to obtain a new certificate.

Common name:
My &pplelD|

< Back l Nexst > I

Cancel

10. Enter the Country/Region, State/Province, and City/locality of your organization. Click Next.

In the Certificate Request File Name window, save the CSR to your computer. Record the location
and filename. This is the file you will upload to the ZENworks Mobile Management Certificate

Request Portal. Click Next.

115 Certificate Yizard
Geographical Information
The certification authority requires the following geographical information.

LCountry/Region:
IUS [United States] Vl

State/province:

IUtah j
Citw/locality:
IF'rovd j
State/province and City/locality must be complete, official names and may not contain
abbreviations.

< Back I Mest » I Cancel

Zard

Certificate Request File Name
Your cerificate request is saved as a text file with the file name you
specify

Enter a file name for the certfficate request.

File name:

c:\AppleMDM_CSR td]

11. Review the information for the certificate request in the Request File Summary window. To make
revisions, click the Back button. Click Next to accept, then click Finish.
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Uploading the CSR to the ZENworks Mobile Management Certificate Request Portal

The CSR file you generated through IS must be signed by Novell before you can upload it to the Apple Push
Certificates Portal. You will need:

e Access to the CSR file

e Your Novell login credentials

1. Navigate to the ZENworks Mobile Management Certificate Portal at
https://zmmupdate.novell.com/apn

Select a certificate signing request to upload.
(File size is required to be less than 10KB.)

Browse... |

GetSigned Request |

2. Browse to select the CSR file.
3. Click Get Signed Request.

4. Save the signed request.

You are now ready to upload the signed ZENworks.request file (the intermediate certificate) to the Apple
Push Certificates Portal.

Uploading the Intermediate Certificate to the Apple Push Certificates Portal

At the Apple Push Certificates Portal, you accept a license agreement and upload the intermediate certificate
that you downloaded from the ZENworks Mobile Management Certificate Portal. A new Apple signed push
certificate is created for you to download.

1. Browse to the Apple Push Certificates portal at: https://identity.apple.com/pushcert/

2. Log in by using your Apple ID and password. This does not need to be an Apple Developer
account ID, but you should use an Apple ID that has been designated for managing the
corporate APNs certificate.
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-

{ ¢ Store Mac iPod iPhone iPad

Apple Push Certificates Portal

Sign in.

Forgot your password?

iTunes

Support Q

Shop the Apple Online Store (1-800-MY-APPLE), visit an Apple Retail Store, or find a reseller. Apple Info Site Map Hot News RSS Feeds Contactus 4
Copyright & 2011 Apple Inc. All rights reserved.  Terms of Use Privacy Policy
3. Select Create a Certificate.
e - = - -
[ ¢ Store Mac iPod iPhone iPad iTunes Support Q

Apple Push Certificates Portal

Get Started

Create a push certificate that enables your third-party server to work with the Apple Push
Notification Service and your Apple devices.

FAQ

Learn more about Mobile Device Management
What about OS X Server?

Shop the Apple Online Store (1-800-MY-APPLE), visit an Apple Retail Store, or find a reseller Apple Info

Copyright © 2011 Apple Inc. All rights reserved.  Terms of Use Privacy Policy

Site Map

devteam@notifycorp.com Sign out

Contact Us é‘

Hot News RSS Feeds

4. Read the Terms of Use and accept the End User License Agreement.
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Store Mac iPod iPhone iPad

Apple Push Certificates Portal

Terms of Use

PLEASE READ THE FOLLOWING LICENSE AGREEMENT TERMS AND CONDITIONS CAREFULLY BEFORE
DOWNLOADING OR USING THE APPLE CERTIFICATES. THESE TERMS AND CONDITIONS CONSTITUTE A
LEGAL AGREEMENT BETWEEN YOUR COMPANY/ORGANIZATION AND APPLE.

MDM Certificate Agreement

(for companies deploying mobile device management for iOS products)

Purpose

Your company, organization or educational institution would like to use the MDM Certificates (as defined

device management of iOS products, or deploy Your own internal mobile device management for i0OS
products within Your company, organization or educational institution. Apple is willing to grant You a limited
license to use the MDM Certificates as permitted herein on the terms and conditions set forth in this
Agreement.

1. Accepting this Agreement; Definitions

1.1 Acceptance

In order to use the MDM Certificates and related services, You must first agree to this License Agreement. If
You do not or cannot agree to this License Agreement, You are not permitted to use the MDM Certificates or
related services. Do not download or use the MDM Certificates or any related services in that case.

I | have read and agree to these terms and conditions.

Printable Version >
-

Shop the Apple Online Store (1-800-MY-APPLE), visit an Apple Retail Store, or find a reseller. Apple Info

Copyright ® 2011 Apple Inc. All rights reserved.  Terms of Use Privacy Policy

below) to enable You to either deploy a third-party commercial, enterprise server software product for mobile

iTunes

3

Site Map

Support Q

devteam@notifycorp.com Sign out

Hot News

v
7
Yol

RSS Feeds Contact Us

)

5. Select and upload the intermediate certificate you downloaded from the ZENworks Mobile

Management Certificate Portal.

Store Mac iPod iPhone

Apple Push Certificates Portal

Create a New Push Certificate

Upload your Certificate Signing Request signed by your third-party server
vendor to create a new push certificate.

Browse._

<D @&

Shop the Apple Online Store (1-800-MY-APPLE), visit an Apple Retail Store, or find a reseller. Apple Info

Copyright © 2011 Apple Inc. All rights reserved.  Terms of Use Privacy Policy

Site Map

Support

devteam@notifycorp.com

Hot News

RSS Feeds Contact Us =

ZENworks Mobile Management 2.5.x Generating an APNs Certificate

Generating an APNs Certificate o 11



6. When the upload has finished, a new certificate for ZENworks Mobile Management appears.
Select Download to download the Apple signed certificate.

.‘ Store Mac iPod iPhone iPad iTunes Support Q

Apple Push Certificates Portal

Certificates for Third-Party Servers

Service Vendor Expiration Date* Status Actions

Mobile Device Management  Novell Inc Jun 15,2013 Active m

“Revoking or allowing this certificate to expire will require existing devices to be re-enrolled with a new push certificate.

About Apple Push Certificates Portal

Create and manage push certificates that enable your third-party server to work with the
Apple Push Notification Service and your Apple devices.
Learn more about Mobile Device Management

MDM push certificates created in the iOS Developer Enterprise Program have been
migrated to the Apple Push Certificate Portal.
Learn more about MDM push certificate migration

Shop ths Appla Onlina Stara (1-300-MY-APFLE), visit an Appla Retail Stora, or find 3 rezalier. Appis Info Sita Map Hot Naws RSS Faads Contact Us é

Copyright © 2012 Appia Inc. All rights razarved. Tarms of Use Privacy Policy

You are now ready to complete the CSR and export the APNs certificate to the ZENworks Mobile
Management server.
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Completing the Certificate Request from IIS Manager 6

1. Return to the IIS Manager. Select Start > Control Panel > Administrative Tools > Internet

Information Services (lIS) Manager.

Right-click any Web site in the left panel. Select Properties.

3. Select the Directory Security tab and then click the Server Certificates button in the Security
section of the menu. This starts the Web Server Certificate Wizard. Click Next to continue.

Select the Process the pending request and install the certificate option and click Next.

Browse to the aps_production_identity.pem file that was provided by Apple. Click Next.

Pending Certificate Request

A pending certfficate request is a request to which the certffication
authority has not yet responded

A certificate request is pending. What would you like to do?
% Process the pending request and install the certfficate

" Delete the pending request

1IS Certificate Wizard E3
Pi a Pending R t
Process a pending certificate request by retrieving the file that contains ®
the certification authority's response. \

Enter the path and file name of the file containing the certification authority's response.

Path and file name:

c:\aps_production_identity. pem| Browse... |

< Back I Nest > I Cancel l

6. On the Certificate Summary screen, verify that the certificate information is correct and click Next,

then click Finish.

7. Open the Microsoft Management Console (MMC). Click Start > Run and enter MMC.

8. From the File menu, select Add/Remove Snap-in.

ZENworks Mobile Management 2.5.x Generating an APNs Certificate
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9. From the drop-down list at Snap-ins added to, select Console Root and click Add. On the Add
Standalone Snap-in screen, select Certificates, then click Add.

Standalore I Extensions I Available standalone snap-ins:

Snap-in | Vendaor | -~
ﬂ.NET Framework 1.1 Configuration  Microsoft Corporation
eE.ﬁ.ctive Directory Domains and Trusks  Microsoft Corporation
ﬁ.ﬁ.ctive Directary Sikes and Services  Microsoft Corporation
@Active Directory Users and Compu...  Microsoft Corporation

Use this page to add ar remove a stand-alane snap-in from the console.

Snap-ins added to: Ia Conscle Root j

gjfl.ﬁ.ctivex Control Microsoft Corporation
Authorization Manager Microsoft Corporation
i ertificate Templates Microsoft Corporation
LiFi ] Microsaft Carporation
@Certiﬁcation Autharity Microsoft Corporation
@Component Services Microsoft Corporation LI
=

r~Description
The Certificates snap-in allows vou ba browse the contents of the
certificate stares for yourself, a service, or a computer.

~ Description

Add Close

Remoyve About, ., |

(a4 | Cancel |

10. On the Certificates snap-in screen, select Computer account and click Next. Choose Local
computer and click Finish.

Certificates snap-in x|

Thiz shap-in will always manage certificates for:

My uzer account

r-
™ Service account
e

Computer account

Select Computer x|

Select the computer you want thiz znap-in ko manage.

— Thiz gnapein will ahways manage:

v iLocal computer: [the computer this consale is rurning onk

i~ ancther computer; I Browse,.. |

[ Allow the selected computer to be changed when launching from the command line. T his
only applies if pou zave the conzole.

11. Click Close. Click OK on the Add/Remove Snap-in screen.
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12. At the Console Root, expand the directory. Select Certificates > Personal > Certificates. Right-click
on the certificate file and select All Tasks > Export. This opens the Export Wizard. Click Next to
continue.

'{ti Console Root'Certificates {Local Computer).Personal'Certificates

[_3 Console Roat
E@ Certificates (Local Compr
E||:| Personal
a Certificates

27 Trusted Root Certific
|27 Enkerprise Trusk Cut | Export...
(23 Intermediate Certific Copry
7] Trusted Publishers Delete
-2 Untrusked Certificate

23 Third-Party Rook Cer Froperties
123 Trusted People Help
7 Certificate Enralimen
- sPC
KN L |

|C|:|ntains actions that can be performed on the item, |

A4l

13. Select Yes to export the private key, then click Next.

Certificate Export Wizard |

Export Private Key
You can choose ko export the private kew with the certificate,

Private keys are password protected, IF you wank ko export the private key with the
certificate, wou must type a password on a later page.,

Do wou wank o export the private key with the certificater?

% ¥es, export the private keyi

™ Mo, do not expart the private key
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14. Select the Personal Information Exchange — PKCS #12 (.PFX) format and select the Enable
strong protection box. Click Next.

Certificate Export Wizard |

Export File Format
Certificates can be exported in a variety of file Formats,

Select the Format wou want bo use:
= DER encoded|binary: %508 {, CER)
" Base-64 encoded %.509 (. CERY
| Cryptographic Message Synbax Standard - FECS #7. Certificates (E7E]

I™ | Include all certificates in bhe certification path if possible

i Personal Information Exchange - PKCS #12 (PR

[ Incdude all certificates in the certification path if possible
¥ Enable strong protection (requires IE 5.0, WT 4.0 SP4 or above)

[ Delete the private kev if the export is successful

< Back I Mext = I Zancel

15. Enter and confirm a password. You will need this password when you upload the certificate to
ZENworks Mobile Management. Click Next.

Certificate Export Wizard [ X] |

Password
To maintain security, you must protect the private key by using a password.

Type and confirm a password.

Password:

Confirm password:

=

< Back I Mext = I Cancel
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16. Click the Browse button and select the .pfx file that you want to export. Click Next.

|
Certificate Export Wizard B3|

File to Export
Specify the name of the file you want to export

File name:

C:lcom.yourcompany.mdm.pfx Browse... I

< Back Cancel

17. Click Finish to complete the certificate export. You see a message that says the export was
successful.

Now you are ready to upload the certificate to ZENworks Mobile Management. You need the
following:

¢ APNs certificate file (.pfx format)

e The password you set when exporting the certificate

Continue with Upload the APNs Certificate to ZENworks Mobile Management.
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Generating an APNs Certificate from Windows Server 2008

The following instructions are for generating an APNs certificate from Windows Server 2008 by using Internet
Information Services (1IS) Manager version 7. You can skip this section if you use Windows Server 2003.
Instructions for 2003 are in another section of this document.

Creating the Certificate Signing Request (CSR) from IIS Manager 7
1. Select Start > Administrative Tools > Internet Information Services (1IS) Manager.

2. Select the server name in the left panel, then double-click the Server Certificates option in the
Security section of the menu.

'?Elnternet Information Services (IIS) Manager
GO (% '

File  View Help

e IPN e
T E)
& Start Page ==
& 33' . Group by:  Area T |@m| v

: B e s

B ‘é,' Application Pools IIS

[#- @] Sites B

e
- — ! |!$
Authentication CGI Compression Default Directory Error Pages Handler
Document Browsing Mappings
- - & - o
: = o |!$"‘ 3 N ﬁ | R
d = & @ ey
Logging MIME Types Modules Qutput Worker
Caching Processes
Management
- o
Feature Shared
Delegation  Configuration

3. From the Actions menu in the right panel, select Create Certificate Request. This starts the Request

Certificate Wizard.

Import...

-~

| Create Certificate Request...

Complete Certificate Request. ..

Create Domain Certificate. ..

Create Self-Signed Certificate. .,
'f@ Help

Online Help
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4. Enter the following in the Distinguished Name Properties window:

¢ Common name — Enter a valid Apple ID. This does not need to be an Apple Developer
account ID, but you should use an Apple ID that has been designated for managing the
corporate APNs certificate. The Apple ID might be in the form of an email address, or
possibly a display name.
Organization — The legal name of your organization
Organization unit — The department within your organization
City/locality — City in which your organization is located
State/province — Abbreviation for the state or province in which your organization is located
Country/region — Abbreviation for the country or region in which your organization is located

Request Certificate | 7|

(|| Distinguished Name Properties

gl

Specify the required information for the certificate. Statefprovince and Cikylocality must be specified
as official names and they cannot contain abbreviations,

Common name: IMy ApplelD

Organization: INnveII Inc

rganizational unit: IIT

Citwilocality IPI’D\-’D

Skate/province: IUtah|

Countryfregion: |L|5 j

Breviaus | Mext I Firishy Zancel

5. Select Next.

6. Inthe Cryptographic Service Provider Properties window, accept the default setting, Microsoft RSA
SChannel Cryptographic Provider. In the Bit length field, select 2048 for the encryption level. Click
Next.

Request Certificate [ X ] ’

Cryptographic Service Provider Properties
)

%3;‘

Select a cryptographic service provider and a bit langth. The bit length of the encryption key
determines the certificate’s encryption strength. The greater the bit length, the stronger the security,
However, a greater bit length may decreasa parformance.,

Cryptographic service provider:

e
Microsoft RSA SChannel Cryptographic Provider

{2048 . =

previous [ Net | roon | concel |
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7. Inthe File Name window, save the CSR to your computer. Record the location and filename. Click
Finish. This is the file you will upload to the ZENworks Mobile Management Certificate Request

Portal.

File Name

g

Specify the File name Faor the certificate request. This information can be sent ta a certification
authaority Far signing.

Specify a file name For the certificate request:

fcrapplemom sk, bxl |

Prewious Iesxk | Finish I Cancel
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Uploading the CSR to the ZENworks Mobile Management Certificate Request Portal

The CSR file you generated by using 1IS must be signed by Novell before you can upload it to the Apple Push
Certificates Portal. You need:

e Access to the CSR file

e Your Novell login credentials

1. Navigate to the ZENworks Mobile Management Certificate Portal at:
https://zmmupdate.novell.com/apn

Select a certificate signing request to upload.
(File size is required to be less than 10KB.)

Browse... |

GetSigned Request |

2. Browse to select the CSR file.
3. Click Get Signed Request.

4. Save the signed request.

You are now ready to upload the signed ZENworks.request file (the intermediate certificate) to the Apple
Push Certificates Portal.

Uploading the Intermediate Certificate to the Apple Push Certificates Portal

At the Apple Push Certificates Portal, you accept a license agreement and upload the intermediate certificate
that you downloaded from the ZENworks Mobile Management Certificate Portal. A new Apple signed push
certificate is created for you to download.

1. Browse to the Apple Push Certificates portal at: https://identity.apple.com/pushcert/ .

ZENworks Mobile Management 2.5.x Generating an APNs Certificate Generating an APNs Certificate o 21


https://zmmupdate.novell.com/apn
https://identity.apple.com/pushcert/

2. Log in by using your Apple ID and password. This does not need to be an Apple Developer
account ID, but you should use an Apple ID that has been designated for managing the

corporate APNs certificate.

Support

Q

Mac iPod iPhone iPad iTunes

.’ Store

Apple Push Certificates Portal

Password

Forgot your password?

Shop the Apple Online Store (1-800-MY-APPLE), visit an Apple Retail Store, or find a reseller. Apple Info Site Map Hot News RSS Feeds Contact Us %
Copyright © 2011 Apple Inc. All rights reserved.  Terms of Use Privacy Policy
3. Select Create a Certificate.
iPad iTunes Support Q

Mac iPod iPhone

.‘ Store

Apple Push Certificates Portal

Get Started

Create a push certificate that enables your third-party server to work with the Apple Push

Notification Service and your Apple devices.

Create a Certificate

FAQ

Learn more about Mobile Device Management
What about OS X Server?

Shop the Apple Online Store (1-800-MY-APPLE), visit an Apple Retail Store, or find a reseller. Apple Info

Terms of Use Privacy Policy

Site Map

devteam@notifycorp.com Sign out

i

Contact Us

Hot News RSS Feeds

Copyright © 2011 Apple Inc. All rights reserved
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4. Read the Terms of Use and accept the End User License Agreement.

Store Mac iPod iPhone iPad Support Q

Apple Push Certificates Portal

Terms of Use

PLEASE READ THE FOLLOWING LICENSE AGREEMENT TERMS AND CONDITIONS CAREFULLY BEFORE ﬂ
DOWNLOADING OR USING THE APPLE CERTIFICATES. THESE TERMS AND CONDITIONS CONSTITUTE A
LEGAL AGREEMENT BETWEEN YOUR COMPANY/ORGANIZATION AND APPLE.

MDM Certificate Agreement
(for companies deploying mobile device management for iOS products)

Purpose

Your company, organization or educational institution would like to use the MDM Certificates (as defined
below) to enable You to either deploy a third-party commercial, enterprise server software product for mobile
device management of iOS products, or deploy Your own internal mobile device management for iOS
products within Your company, organization or educational institution. Apple is willing to grant You a limited
license to use the MDM Certificates as permitted herein on the terms and conditions set forth in this
Agreement.

1. Accepting this Ag it; D

1.1 Acceptance

In order to use the MDM Certificates and related semvices, You must first agree to this License Agreement. If
You do not or cannot agree to this License Agreement, You are not permitted to use the MDM Certificates or
related services. Do not download or use the MDM Certificates or any related services in that case.

I | have read and agree to these terms and conditions.

Printable Version >

Shop the Apple Online Store (1-800-MY-APPLE), visit an Apple Retail Store, or find a reseller. Apple Info Site Map Hot News RSS Feeds Contact Us

Copyright ® 2011 Apple Inc. All rights reserved.  Terms of Use Privacy Policy

5. Select and upload the intermediate certificate you downloaded from the ZENworks Mobile
Management Certificate Portal.

Store Mac iPod iPhone iPad iTunes Support Q

Apple Push Certificates Portal

Create a New Push Certificate

Upload your Certificate Signing Request signed by your third-party server
vendor to create a new push certificate.

Browse._

i -

S

Shop the Apple Online Store (1-800-MY-APPLE), visit an Apple Retail Store, or find a reseller Apple Info Site Map Hot News RSS Feeds Contact Us

Copyright © 2011 Apple Inc. All rights reserved.  Terms of Use Privacy Policy
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6. When the upload has finished, a new certificate for ZENworks Mobile Management appears.
Select Download to download the Apple signed certificate.

.‘ Store Mac iPod iPhone iPad iTunes Support Q

Apple Push Certificates Portal

Certificates for Third-Party Servers

Service Vendor Expiration Date* Status Actions

Mobile Device Management  Novell Inc Jun 15,2013 Active m

“Revoking or allowing this certificate to expire will require existing devices to be re-enrolled with a new push certificate.

About Apple Push Certificates Portal

Create and manage push certificates that enable your third-party server to work with the
Apple Push Notification Service and your Apple devices.
Learn more about Mobile Device Management

MDM push certificates created in the iOS Developer Enterprise Program have been
migrated to the Apple Push Certificate Portal.
Learn more about MDM push certificate migration

Shop ths Appla Onlina Stara (1-300-MY-APFLE), visit an Appla Retail Stora, or find 3 rezalier. Appis Info Sita Map Hot Naws RSS Faads Contact Us é

Copyright © 2012 Appia Inc. All rights razarved. Tarms of Use Privacy Policy

You are now ready to complete the CSR and export the APNs certificate to the ZENworks Mobile
Management server.
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Completing the Certificate Request from IIS Manager 7

1. Return to Internet Information Services (IIS) Manager > Server Certificates and select Complete
Certificate Request from the Actions menu in the right panel. This starts the Complete Certificate

Request Wizard.

Import...

Create Certificate Request...

#Complete Certificate Request...

Create Domain Certificate. ..

Create Self-Signed Certificate. ..

'6 Help
Online Help

2. Browse to the aps_production_identity.pem file that was provided by Apple and enter a friendly hame.
This is simply a label you give the certificate to easily distinguish it. You might want to give it a name
in which your company is identified.

Complete Certificate Request [ 2 | X]

Specify Certificate Authority Response

g’

Complete a previously created certificate request by retrieving the file that contains the certificate
authority's response,

File name containing the certification authority's response:
|C:'|,aps _production_identity.pem |

Friendly name:

Icom.yourcompany.mdml

OK I Cancel |

3. Select OK to install the certificate to the server. You should see the certificate listed in the center
panel of Server Certificates.
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4. Export the certificate so that it can be uploaded to ZENworks Mobile Management. Right-click the
certificate you just installed and select Export.

'!Elnternet Information Services {I1IS) Manager H=] B3
@,” (&5 » @~ @ -
File  View Help
. N @) Server Certificates e
e',' 1 | Is' % Imiport...
©5 Start Page: ) B ) ) i
-8 Use _thls feature ko request and manage certificates that the Web server can use with Web sikes Create Certificate Request...
. = application Pools configured for SSL. Complete Certificate: Request...
53 .:_ Sites Mame ~ I Issued To | Issued By

Create Domain Certificate. ..

com. yourcompany, DM Apple Produckes Dk

Create Self-Signed Certificate. ..

Create Certificate Request... Wiew...
Complete Certificate Request. .. Export...
Renew...
Create Domain Certificate... % Remove
Create Self-Signed Certificate... g. Help
View... Online Help
I Export. .. I
Renew. ..
X Remove
@‘ Help
Online Help

5. Save the file to your Desktop in the .pfx format. You must set a password. You will need this
password when you upload the certificate to ZENworks Mobile Management.

Export Certificate EHE

Export bo:
IC:'l,cu:um.ynurcnmpany.mdm.pfx - |

Passwiord;

Confirm password:

Ik I Cancel

You have successfully generated your APNs certificate.

Now you are ready to upload the certificate to ZENworks Mobile Management. You need the
following:

e APNs certificate file (.pfx format)

e The password you set when exporting the certificate

Continue with Upload the APNs Certificate to ZENworks Mobile Management.
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Uploading the APNs Certificate to
ZENworks Mobile Management

This section explains how to upload the APNs certificate to ZENworks Mobile Management by using the
ZENworks Mobile Management dashboard. You need:

e APNSs certificate file (the .pfx format)

e The password you set when exporting the certificate

1. Log into the ZENworks Mobile Management dashboard and select the System view.
2. Select Organization from the left panel.
3. Click the Upload button next to the APNs Certificate field.

Apple Push Notifications X

Choose an APNs Certificate File: Browse...
aps_developer_identity_stO1.pfx

RRERRTRN

Password:

Use Default URLs:  [V]
Server URL:

Check in URL:

I Submit

4. Click the Browse button, then navigate to and select the APNs certificate file (.pfx format).
5. Enter the password you set when exporting the certificate.
6. Select the Use Default URLs box.

If you did not access the dashboard externally, do not use the default check box. Enter the Server URL
and Check in URLs manually, in the format Error! Hyperlink reference not valid.
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7. Click the Submit button.

After you have uploaded an APNs certificate, it appears under the APN Certificate field on the
dashboard in the format com.apple.mgmt.<random string> (Enabled)

APNs Certificate:

com.apple.mgmt.External.115ggh79-1t2d-417t-85022-6b100910412 (Enabled)

8. Click Save Changes when you are finished.

Your ZENworks Mobile Management server is now able to trigger iOS devices with push notifications and
use the built-in Apple MDM protocol.

Updating the APNs Certificate

1. Log into the ZENworks Mobile Management dashboard and select the System view.
2. Select Organization from the left panel.

3. Click the Edit button next to the APNs Certificate field and make the needed changes. You can
change/disable/delete the APNs certificate or edit the URLSs if necessary.

Apple Push Notifications X

Chooseanaction:  (3) change APNs Certificate
(O Disable APNs Certificate

(O Delete APNs Certificate

Choose an APNs Certificate File:

Password:

Use Default URLs:  []

Server URL: Ihttps:,."v/ssI.ntouchall

Check in URL: Ihttp5:,v"_.-’ssI.ntouchaIJ

Submit

4. Click the Submit button.
5. Click Save Changes when you are finished.

Tip: You might want to test APNs functionality after an update to the certificate by manually
updating the APN profile on a device. Open ZENworks Mobile Management on an iOS device
and tap Config > Load Configuration Profile. The device installs the initial profile and, after a
brief delay, it prompts for the user’'s Exchange password. If the prompt for Exchange credentials
does not occur, resetting IIS might resolve issues preventing the APNs from processing.
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Renewing an APNs Certificate

The Apple Push Notification service (APNs) certificate must be renewed annually. Organizations should keep
track of the certificate’s expiration date, because there is no automatic renewal notification as the expiration
date approaches.

Follow the instructions below to renew the APNs certificate that was generated from the Apple Push
Certificates Portal or from Apple’s iOS Developer Enterprise Program (iDEP).

Essentially, you follow the same process used to obtain the original certificate. The only difference is in the
steps taken on the Apple Push Certificates Portal (Steps 4-6 below.)

To renew an APNSs certificate:

1.

Create a new Certificate Signing Request (CSR) by using IS Manager (See the complete
instructions: [IS Manager 6 or |IS Manager 7)

Upload the CSR to Novell's ZENworks Mobile Management Certificate Request Portal. Click Get
Sighed Request and save the signed request file. See the complete instructions on page 21.

Go to the Apple Push Certificates Portal at https://identity.apple.com/pushcert/ .

If you originally obtained the certificate from the Apple Push Certificates Portal, log in with the
Apple ID you used to generate the certificate.

If you originally obtained the certificate through iDEP, log in with the Apple ID for the iDEP
Agent account.

On the page where your certificate is listed, click the Renew button next to the APNs certificate you
are renewing.

‘ Store Mac ‘ iPod iPhone iPad iTunes Support Q
Apple Push Certificates Portal thurketi@nstiycorp
Certificates for Third-Party Servers [ Create a Cersfcate |
Service Vendor Expiration Date™ Status Actions
Mobile Device Management  Novell Inc Jun 15,2013 Active m

“Revoking or allowing this certificate to expire will require existing devices to be re-enrolled with a new push certificate.

About Apple Push Certificates Portal

Create and manage push certificates that enable your third-party server to work with the
Apple Push Notification Service and your Apple devices.
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5. On the Renew Push Certificate page, click the Browse button and select the .plist file to upload. Click
Upload.

iPhone

iTunes Support

Apple Push Certificates Portal

Renew Push Certificate

Enter your Certificate Signing Request signed by your third-party server
vendor to renew the following push certificate.

Service  Mobile Device Management
Vendor

6. The page where certificates are listed displays the certificate with a new expiration date. Click the
Download button next to the renewed certificate to download it and save it as a .pem file.

Use IIS to complete the CSR (See the complete instructions: IS Manager 6 or IS Manager 7)
From the ZENworks Mobile Management server dashboard, upload the renewed certificate.

Select System > Organization.

Click the Edit button next to the APNs Certificate field and choose Change APNs Certificate.
(See complete instructions: Updating the APNs Certificate).
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